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Additional Information

Simple operation for color profiling tasks
The ColorLogic philosophy toward color management tools is a 
simple set of tools with highly powerful options. CoPrA will produce 
high quality profiles with just a few clicks with simple, easy to use 
tools. CoPrA can create printer, DeviceLink and SaveInk profiles 
with Multicolor options for typical day-to-day color management 
challenges. The simple and quick setup of CoPrA – outlined in 
this Quick Start Guide – demonstrates the power of ColorLogic's 
CoPrA.

CoPrA Documentation
ColorLogic's CoPrA offers some of the most intelligent and 
advanced profiling tools in the industry today. CoPrA's help buttons 
are represented with the ? icon, and have detail and up-to-date 
information.

Automatic Updates
CoPrA includes an automatic update function that can be enabled or 
disabled by going to Help>Check for Update
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INSTALLING 
COPRA

Getting started 
with CoPrA 3
Installation, requesting demo licenses, 
loading licenses and permanent licenses
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Installing CoPrA 3 
System requirements
Mac OSX 
10.5 or later - (Intel only)
Windows:
Windows XP, Vista, Windows 7, 
Windows 8 
Installers for the respective plat-
form installs the program by default 
in either the Applications folder 
(Macintosh) or the Program files 
(x86) folder (Windows). Begin 
installation by double-clicking on the 
CoPrA installation package.
After accepting the Software License 
Agreement, select the destination 
volume and choose between a 
Standard Installation or custom 
installation. Standard Installation 
installs all components including the 
UPPCT tool as described below. 
Custom installation lets you choose 
to install UPPCT.

UPPCT – CoPrA contains the 
option of directly measuring test 
charts for profile creation with the 
3rd party software UPPCT, rather 
than measuring and saving them 
exclusively via external measuring 
software and then importing them 
into CoPrA.

Computer vs USB 
dongle license
A computer-based CoPrA license 
always refers to a the specific com-
puter on which CoPrA was installed 
and can be requested for temporary 
test purposes. Computer licenses are 
also advantageous if the computer 
has no USB ports or no space for a 
USB dongle, i.e. a rack server.
USB dongle licenses are serialized to 
the CoPrA USB dongle. The CoPrA 
USB dongle is shipped with the per-
manent license of CoPrA and permits 
use of CoPrA on different comput-
ers. To be able to assign the license 
to the USB dongle, the dongle must 
be connected before starting CoPrA.

Demo license request
CoPrA allows users to request a 
demo license for 14 days for software 
evaluation. The restriction of running 
CoPrA in demo mode is all profiles 
are encrypted and can be used with 
ColorLogic applications only.
To request a demo license follow 
the steps below:

1. Click the Registration button 
located on the lower left hand corner 
of the Main Navigation Panel.
2. Click on the Demo license 
request tab. 

01 INSTALL
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3. Enter all required information. 
4. When your location is chosen, 
CoPrA will show the available dealers 
for your region. Select a dealer and 
click Send direct request. A demo 
license file will be automatically sent 
to the email address supplied in the 
contact form.
5. Save the license file contained in 
the email (indicated by the ending 
*.lic) to your system. 
6. Under License details in the 
Registration window and select the 
*.lic file. After installing the demo 
license file, the expiration date of the 
demo license is shown below the 
License details.

Restrictions with Demo 
licenses and CoPrA
CoPrA demo license gives users 
a 14 day evaluation period to try 
all the functions of CoPrA within 
the application. When a profile 
is generated with CoPrA while 
running with a demo license, the 
only restriction is that the profiles 
generated are encrypted and can 
only be used within ColorLogic 
applications. To apply a demo profile 
to a test image, follow the instructions 
on using the Image Conversion 
(described on page 22) function 
located within CoPrA.
If it becomes necessary to decrypt a 
demo profile during the test period, 
contact your dealer for instructions.

Purchasing CoPrA
Select from one of our base CoPrA 
packages (located on page 8). Click 
on Buy ColorLogic products under 
License details or Demo license re-
quest in the Registration window.

A list of contacts will open in your 
browser, where you can locate a deal-
er. By selecting the dealer you will be 
forwarded to the dealers homepage 
to find his contact details. 

Installing a permanent 
license 
A permanent license provided by the 
individual dealer will be supplied after 
purchasing CoPrA. The permanent 
license is available in the form of a 
computer-based license or a dongle 
license (see previous section).
After purchasing the software, a per-
manent license file (*.lic) will be sent 
via email. Load the license file under 
License details in the Registration 
window.
After installing the permanent license 
file, the licensed modules are displayed 
under the License details.
Profiles created with the permanently 
licensed version can be used in all 
ICC compliant programs that support 
DeviceLink profiles and device profiles 
such as ColorLogic's ZePrA Color 
Server.
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COPRA S COPRA M COPRA L COPRA XL COPRA XXL

STANDARD
FEATURES

Package Features
M

Package Features
L

Package Features
XL

Package Features
XXL

RGB, Gray 
Profiling

Includes all 
features of 
S Package

Includes all 
features of S, M 

Packages

Includes all 
features of 
S, M, L 
Packages

Includes all 
features of S, M, 
L, XL Packages

Profile Manager CMYK Profiling
DeviceLink 
Creation & 

Editing

SaveInk Profiles
Create SaveInk

DeviceLinks

Edit DeviceLinks 
up to 

16 channels

Simplified
Navigation

ColorAnt
Analyze & Optimize 
Measurement data

Generate XML
Reports

Multicolor 
Profiles

CMYK + 3 channels

CoPrA 3 BASE PACKAGES

CoPrA 3 ADD-ON MODULES

COPRA MODULE OPTIONAL FEATURES

DeviceLink Profile Module DeviceLinks for Gray, RGB, CMYK

DeviceLink Edit Module Creates DeviceLink profiles based on 
Editing for Gray, RGB, CMYK

SaveInk Module Create SaveInk DeviceLinks

Multicolor Module Multicolor support for Printer and/or 
DeviceLink profiling and/or Editing

Multicolor Module 
With Option for use in ZePrA

Enables Multicolor Support for 
CoPrA and ZePrA

› CoPrA 3 Packages and Add-Ons
CoPrA 3 base packages now include more features and the flexibility 
to add specific modules to changing needs. 
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MAIN
PANEL

CoPrA's Main 
Navigation Panel
Access all of CoPrA 3 functions from one 
centralized location.
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02 PANEL
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Create Printer Profile

Printer Profiling

DeviceLink Editing SaveInk

Image Conversion Profile Manager Batch Overview

Create DeviceLink Profile

ToolBox

Registration Home Preferences



NAVIGATION PANEL

PANEL
CoPrA's Redesigned Interface
CoPrA 3's interface has been redesigned to include a navigation panel 
to quickly access all main profiling functions from one easy-to-use panel. 
Graphical illustrations display the purpose of each function on the panel. 

Printer Profiling
Create printer profiles with a variety of options

Create DeviceLink profiles
Create DeviceLink profiles from standard ICC profiles

Create DeviceLink profiles by Editing
Create DeviceLinks via edit charts

Create SaveInk DeviceLink profiles
Generate SaveInk ink optimizing profiles from CMYK ICC profiles

Image Conversion
Convert images using a variety of profiles

Profile Manager
Manage profiles in one convenient place

Batch Overview
View progress of profile generation, create reports for individual 
profiles, generate preview profiles, manage profiles 

IMAGE

Online Help 
Online help is available through clicking any of the ? located on 
any of the application windows. 

Registration - Home - Preferences
Registration - Access the Registration and license dialog
Home - Return to CoPrA's Home screen
Preferences - Access CoPrA's Preferences, including home page 
selection, overwriting preview profiles and default report options

?

11
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PRINTER
PROFILING

Getting started 
with Printer Profiling
How to create a printer profile using 
optimized measurement data
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Printer Profiling 
CoPrA’s profiling functionality is de-
pendent on which base package and 
modules are purchased (all modules 
and options are 
available with a 
demo license). 
Depending on the 
package and mod-
ules purchased, 
CoPrA will profile 
the following color spaces: Gray, 
RGB, CMY, CMYK or Multicolor. 

Creating printer profiles (Fig 3.1) in 
CoPrA involves loading measurement 
and reference data and selecting the 
settings for profile generation. The 

profiling Settings 
are a special 
feature of CoPrA 
and can be saved 
and re-used or ed-
ited. This ensures 
consistent profiling 

and increased color quality in pro-
duction. Once the required profile 

03 PROFILING

Drag and Drop measurement 
data directly into the window 
or onto the load button.

Printer Profiling - Main Window
FIG 3.1
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quality is achieved with quality results 
using a particular set of settings, 
retrieve these settings to create new 
profiles based on new measurement 
data - with no color management 

expertise. CoPrA includes a number 
of standard settings (Digital Printing, 
Inkjet etc.) that are available with 
the standard installation for output 
profiling, in addition to the option of 
creating specialized settings for par-
ticular production environments. The 
additional rendering intents help the 
user to achieve the very best profile 
quality according to their needs. 
Some CoPrA advanced options for 
profile creation include the ability to 
adapt a profile to viewing conditions, 
compensate for optical brightener 

and the ability to set a highlight start-
ing point. The different modes for 
controlling the black channel permits 
specific control of the separation 
characteristics. These options are 

complemented by the numerous 
possibilities for defining exceptions.

Quick Start Procedure
1. Load measurement data by click-
ing on the Load button, dragging and 
dropping on the window or click the 
Measure button to start the UPPCT 
tool (instructions on page 26).
2. Use the Settings button to 
select one of CoPrA's predefined 
settings and click Next. 

Printer Profiling - Output Window - Batch Profile shortcut
FIG 3.2

CoPrA's footer shows 
information on profile 
generation progress
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3. If further customization of 
the profile is necessary, click the 
Customize button to access CoPrA's 
comprehensive set of options. Help 
for individual functions is available 
Online by clicking any of the ? to 
access Online help.
4. Click Next. CoPrA by default 
names the profile based on the 
measurement data and setting 
selected. You may 
customize the name 
of the profile (Fig 
3.2) Choose the 
ICC Format (V2 or 
V4), next select the 
Size of the profile 
(defines grid points 
in the profile). The 
option is available to 
generate a detailed 
Profile Report (Fig 
3.3) that contains 
in-depth information 
on profile statistics, 
gamut, gamut 
volume, gray balance, 
conversions, hue 
samples, linearity and 
dot gain. The number 
of report pages will 
vary depending on 
the type of profile 
being generated.
5. By clicking the 
Save button and as 
profile processing be-
gins, either by going 
back to the 

navigation panel and clicking Batch 
Overview to view the processing prog-
ress. (Shortcut: click on the bottom 
center to go directly to the Batch 
Overview or keyboard shortcut cmd 
8).

Profile-Test

2014-04-21

Profile Information

Name CL-CMYK-IT874 Corrected_Digital Printer.icc
Path /Users/crossxcolor/Library/ColorSync/.../CL-CMYK-IT874 Corrected_Digital Printer.icc
Size 1271100
Version 2.4
Class prtr
ColorSpace CMYK
PCS Lab
Date 2014-04-21 09:17:08
Rendering 0
Creator CoLg

1. Profile Statistic

The statistic tests the profile integrity and some profile properties.
The profile integrity indicates how precise a profile converts between the color spaces. The integrity values show as 
average and maximum deviations.
The DCS to PCS statistic shows how precise the profile matches the measurement data and should be very low.
The black point DCS for RGB profiles should be low or 0/0/0
The black point DCS for CMYK+ profiles should match the allowed total amount of ink.
The black point PCS should be dark and approximately neutral.
The white point DCS should match the device white point.
The white point PCS should match Lab-White.

Integrity (DCS) perceptual 2.7/22.7 (Avg/Max CMYK)
Integrity (DCS) relative colorimetric 2.8/49.0 (Avg/Max CMYK)
Integrity (DCS) saturation 4.0/25.4 (Avg/Max CMYK)
Integrity (PCS) perceptual 2.9/25.8 (Avg/Max Lab)
Integrity (PCS) relative colorimetric 1.4/7.9 (Avg/Max Lab)
Integrity (PCS) saturation 4.5/34.1 (Avg/Max Lab)
Precision (DCS-to-PCS) absolute colorimetric 0.1/1.3 (Avg/Max Lab)
BlackPoint (PCS-to-DCS) perceptual 54.5 71.2 74.3 100.0 (CMYK) TAC=300.0%
BlackPoint (PCS-to-DCS) relative colorimetric 54.5 71.2 74.3 100.0 (CMYK) TAC=300.0%
BlackPoint (PCS-to-PCS) perceptual 20.94 0.13 0.08 (Lab)
BlackPoint (PCS-to-PCS) relative colorimetric 20.94 0.13 0.08 (Lab)
WhitePoint (PCS-to-DCS) perceptual 0.0 0.0 0.0 0.0 (CMYK)
WhitePoint (PCS-to-DCS) relative colorimetric 0.0 0.0 0.0 0.0 (CMYK)
WhitePoint (DCS-to-PCS) perceptual 100.00 0.00 0.00 (Lab)
WhitePoint (DCS-to-PCS) relative colorimetric 100.00 0.00 0.00 (Lab)
WhitePoint (DCS-to-PCS) absolute colorimetric 94.00 0.02 -2.76 (Lab)

Printer Profiling - Profile Report example
FIG 3.3
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DEVICELINK
PROFILING

Create DeviceLink 
Create DeviceLink from Device Profiles

DeviceLink by Editing
Create DeviceLink profiles by editing

SaveInk DeviceLink
Create DeviceLink profiles for ink saving 
or TAC reduction
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DeviceLink Profiling
DeviceLink profiles complement the 
use of "normal" ICC device profiles 
(device profiles are printer, monitor, 
and scanner profiles) and are applied 
to certain tasks in order to achieve 
substantially better results in terms of 
quality and printing when converting 
and adapting colors. DeviceLink pro-
files specifically 
avoid many of the 
weaknesses of 
color conversion 
based on ICC 
device profiles. 
CoPrA can create 
DeviceLink profiles for all combi-
nations of color spaces: Gray, RGB, 
CMYK, Multicolor. The most import-
ant applications are CMYK-to-CMYK, 
RGB-to-CMYK and CMYK-to-
Multicolor. To create DeviceLink 
profiles, a pre-configured ICC printer 
profile is required. If there is no ICC 
printer profile for a printing process 
or an output device, simply create 
it in the CoPrA Printer Profiling 
module.

Quick Start Procedure
1. Load the Source and Target 
profile(s).

2. From the Settings drop down 
menu, select the appropriate pre-
defined setting for your production 
task. ColorLogic recommends 
starting with one of the predefined 
settings supplied.
3. Click the Next button and pro-
ceed to or click Customize. For more 
detailed descriptions click the ? to 
access CoPrA's Online help.

4.   Name the 
profile and set 
the ICC Format, 
Size of the ICC 
profile and the 
option to gen-

erate a detailed report or generate 
a preview profile (useful for visual 
checking) and click Save.
5. To check the progress of profile 
generation, click to Batch Overview 
by accessing the main panel, or key-
board shortcut cmd 8.

DeviceLink profiles by 
editing
One of the most powerful features of 
CoPrA is creating DeviceLink profiles 
with the DeviceLink Editing module. 
These profiles can e.g be applied in 
automated fashion in a workflow 
program that supports DeviceLink 
profiles (e.g. ZePrA).

Use one of the predefined 
settings as a starting point to 
create DeviceLink profiles

04 DEVICELINK
PROFILING
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Simply open one of the supplied 
CoPrA Edit Charts (for CMYK, RGB 
or Grayscale) that are installed with 
CoPrA in an image editing program 
which have the tools to apply (e.g. 
Adobe Photoshop) the color correc-
tions required. It is possible to add 
other image data to the Edit Charts. 
The corrections must be applied 
globally to the entire Edit Chart. 

Contained in the upper left corner 
there is a specially designed element 
that CoPrA will measure. Based 
on the editing, CoPrA then calcu-
lates a new DeviceLink profile. This 
powerful function can be put to a 
wide variety of uses: recurring color 
corrections on different sets of image 
data, specifically prepare RGB image 
data for four-color or multicolor 

printing, apply gradation curves in the 
profile rather than in the RIP, create 
special effects or simply fine-tune an 
existing DeviceLink profile. 

Quick Start Procedure
1. Open one of the ColorLogic 
edit charts located in Tools>Open 
EditTargets folder

2. Edit the appropriate target 
in any image editing program (i.e. 
Photoshop) and save as. 
Note: Remember the size and posi-
tion of the Control Element cannot 
change.
3. Open the edited chart in the 
DeviceLink Editing module and 
apply any of the options available for 

DeviceLink Editing - Main Window
FIG 4.1
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Purifying Colors, choosing source 
and target profiles etc. (details avail-
able in the Online help).

SaveInk DeviceLink 
Profiles
By optimizing the black composition 
of the data, SaveInk DeviceLink 
profiles make it possible to reduce 
the amount of cyan, magenta and 

yellow used - without any loss of 
quality and control the amount of 
TAC (total area coverage) reduction. 
Applying this function to a moderate 
degree enhances the stability of 
the printing process, while use of a 
stronger level saves even more ink. 
Additionally SaveInk functionality 
can also be combined with the other 

options available in CoPrA, e.g. color 
space conversion + SaveInk.

Quick Start Procedure
1. Load the CMYK Printer Profile 
either by selecting in the menu or 
dragging and dropping onto the 
menu.
2.  Select the Setting by using any 
of the predefined settings in the list. 

For advanced settings click on the 
Customize button (detailed informa-
tion available via Online help Fig 4.2).
3. Name the profile, choose the 
ICC Format and Size of the profile; 
click the Profile Report to create a 
report.

SaveInk DeviceLinks - Customization window
FIG 4.2
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COPRA
TOOLBOX

Image Conversion
Convert images using standard 
ICC profiles and DeviceLinks

Profile Manager
Manage all types of ICC profiles, 
analyze and compare profiles

Batch Overview
Overview of all profiling jobs, 
create reports, create preview profiles

IMAGE
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Image Conversion
CoPrA will convert PSD, TIFF and 
JPEG files (Fig 5.1) with the help of 
ICC device profiles and DeviceLink 

profiles. This function is very useful 
for checking the profile quality on 
images, since typical application pro-
grams often do not support all types 
of DeviceLink (i.e. RGB to CMYK) 
or multicolor profiles. 

When CoPrA 3.0 has a demo 
license installed, the application will 
allow the conversion of images with 

CoPrA demo profiles for further 
evaluation in other programs (i.e. 
Photoshop).

Profile Manager
The Profile Manager tool has been 
integrated in the CoPrA package. 

05 TOOLBOX

Image Conversion- Main Window
FIG 5.1

Click "Source File" or 
simply drag and drop an 
image to be converted.
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It allows to directly view, organize, 
analyze, compare or even adapt pro-
files after creation within the CoPrA 
environment (Fig 5.2). The main 
window in Profile Manager allows 
users to view the profiles located 
on a system. The unique ability of 

Profile Manager to display all types 
of profiles, (including DeviceLink and 
Multicolor Profiles) is a powerful 
tool for everyday color manage-
ment. Profile Manager includes 5 
different tabs (General, Curves, 
Gamut, Colorants, Workflow) or 
verify and check the quality of a pro-
file by means of a profile report. 
Note: Detailed information regard-
ing the individual tabs and functions 
of Profile Manager can be found in 
CoPrA's Online help.

Batch profiling
Batch profiling functions are incor-
porated in CoPrA allowing power 
users to create several profiles 
at once and perform additional 
functions once profiles have been 
generated. 

Some of the advantages
of batch profiling: 
While the first profile is already in 
the process of being calculated, load 
new measurement data, prepare the 
next profile(s) and create variations. 
All profiles to be calculated are 
displayed in the Batch Overview and 
are processed one after the other. 
With batch profiling and calculating 
numerous profiles successively, it 
is not necessary to wait until the 

Profile Manager - Main Window
FIG 5.2
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calculation of the current profile to 
be completed before preparing the 
next profile for calculation.
Located at the top of the Batch 
Overview window is a tool bar that 
will perform various functions,  
including: Start, Stop, Deletion of 

profiles. Direct access to the Profile 
Manager or revealing the profiles on 
an individual system can be done 
directly from the toolbar.
The toolbar also includes the ability 
to create PDF or XML reports 
(XML requires CoPrA L package or 
higher), create preview profiles and 
access Profile Manager. 

Quick Start Usage
1. Select any of the already pro-
cessed profiles in the window.
2. The toolbar (Fig 5.4) will show 
the available actions that can be 
performed on the profiles that have 
been generated.

3. Select the profile in the main 
window (by a single click) and 
choose the function required.

Batch Overview - Main Window
FIG 5.3

Batch Overview - Toolbar close-up FIG 5.4
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Ugra UPPCT
Measure test charts using Ugra 
UPPCT tool within CoPrA

ColorLogic ColorAnt
Optimize measurement data 
before profiling
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Measure test charts 
with UPPCT
The CoPrA Printer Profiling module 
has the option of directly measuring 
test charts for profile creation via 
the UPPCT software tool (Fig. 6.1)
from Swiss Center of Competence 
for Media and Printing Technology 
Ugra, rather than measuring and 
saving data via an external measur-
ing software and then importing the 
data into CoPrA. 

To access the UPPCT tool:

1. From the CoPrA Printer Profile 
module, click Measure and launch 
UPPCT.
2. Choose the measuring chart 
from the Wedges Types dialog. For 
custom charts including ColorLogic's 
test charts, click Others and the se-
lect the desired chart from the pull 
down menu.

3. Measure the test chart, using 
your preferred supported mea-
surement device. When complete, 
press Transmit to copy the data into 
CoPrA.

ColorLogic ColorAnt 
Optimize measurement 
data 
When setting up color management 
during the process, it is unavoid-
able that one or more of your 

color targets 
may contain 
redundant, 
non-matching, 
or just inac-
curate data 
on the same 
test chart. 
Most color 
charts contain 
over 1000 
test patches, 
inaccurate and/
or erroneous 
information 
may be read. 
CoPrA 

packages M 
and higher include a license for 
ColorLogic's ColorAnt (ColorAnt 
must be installed separately) for 
optimizing measurement data.
Note: ColorLogic highly recom-
mends optimizing measurement data 
prior to profiling.
ColorAnt includes both the options 
to have measurement data checked 
automatically (Fig 6.2) by clicking 
Automatic or use a variety of 

UPPCT dialog box
FIG 6.1
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comprehensive tools that include: 
redundancy checking, optical 
brightener correction, smoothing, 
rescaling data to specific test charts, 
correcting tonal curves, white point 
correction, averaging, merging 

or transforming via ICC profiles. 
ColorAnt also includes a full set 
of analysis tools for viewing and 
comparing measurement data. 

Quick Start Procedure
1. Launch ColorAnt and load 
existing measurement data by either 
File>Open, or drag and drop mea-
surement data to the left hand side 
of the main window.
2. To have ColorAnt automatically 
analyze and correct the measure-
ment data, click the Automatic 
button.

3. After the data has been pro-
cessed, the results of the processing 
can be checked if required.  
Go to File>Save to save corrected 
data.

ColorAnt Main Window
FIG 6.2

ColorAnt 3D view sample
FIG 6.3
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